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This document provides detailed delivery information for all accepted media and files for the iTunes Store,
including music, music video, television, and movies. If further details are required, contact your iTunes Technical
Representative.

Introduction
Quality is important to us at iTunes. We expect to receive the highest-quality assets available. Our product
must meet or exceed the quality of the physical product already out in the marketplace. For example, if 5.1
surround sound or closed captions exist on the physical version of the product, those must be provided. If the
physical product gives the chapters actual names (as opposed to Chapter 1, Chapter 2, and so on), then our
product should have those same chapter titles. If the album is in stereo, stereo audio must be provided.

Changes Made in this Release

Changes MadeDate/Version

Album cover art and poster art requirements have changed. Removed
TIFF from the list of recommended image formats and removed DPI
requirements. Added delivery requirements for dub card video. 96Khz
audio is now supported.

May 30, 2012 - Version 5.0

For a complete history of changes, see “Previous Spec Revisions” (page 28).

What’s New in the iTunes Video and Audio Asset Guide 5.0?
Music: Album Cover Art

Album cover art must be at least 1400 x 1400 pixels (2400 x 2400 pixels recommended for best results) with
a 1:1 aspect ratio. The file must be a high-quality JPEG with .jpg extension or PNG with .png extension. Do
not increase the size of a smaller image to meet the minimum size standard. Excessively blurry or pixelated
images will be rejected.
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Music: Audio Source Profile

The iTunes Store accepts audio with a sampling rate of 96Khz and 24-bit resolution for album tracks and
ringtones.

TV: Cover Art

TV cover art must be at least 1400 x 1400 pixels (2400 x 2400 pixels recommended for best results) with a 1:1
aspect ratio. The file must be a high-quality JPEG with .jpg extension or PNG with .png extension. Do not
increase the size of a smaller image to meet the minimum size standard. Excessively blurry or pixelated images
will be rejected.

Film: Poster Art

Poster art must be at least 1400 x 2100 pixels with a 2:3 aspect ratio. The file must be a high-quality JPEG with
.jpg extension or PNG with .png extension. Don't increase the size of a smaller image to meet the minimum
size standard. Excessively blurry or pixelated images will be rejected.

Film: Dub Card Video

Added delivery requirements for dub card video files. See “Film Dub Card Video Profile” (page 24).

Overview
Changes Made in this Release
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Music Audio Source Profile
The iTunes Store accepts audio with a sampling rate of 44.1Khz and 16-bit or 24-bit resolution and 96Khz with
24-bit resolution. Note that the audio source must be stereo unless it does not exist.

Uncompressed audio formats supported are:

Qualified CODECContainer TypeFormat

WAV (.wav)Pulse-Code Modulation (PCM)

QuickTime http://www.apple.com/quicktime

iTunes http://www.apple.com/itunes

M4A (.m4a)Apple Lossless (ALAC)

iTunes ProducerCAF (.caf)

FLAC http://flac.sourceforge.netFLAC (.flac)Free Lossless Audio Codec (FLAC)

All other audio formats will be rejected.

Important  All audio must be generated using a CODEC qualified and approved by Apple.

Pre-Cut Ringtone Source Profile
The iTunes Store accepts pre-cut ringtones with a sampling rate of 44.1 kHz and 16-bit or 24-bit resolution and
96Khz with 24-bit resolution. Note that the audio source must be stereo unless it does not exist. The audio file
must be lossless and be one of these formats: WAV, FLAC, ALAC. The minimum length is 5 seconds and the
maximum length is 30 seconds.

See the table above for the uncompressed audio formats that are supported. All other audio formats will be
rejected.
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Important  All audio must be generated using a CODEC qualified and approved by Apple.

Music Album Cover Art Profile
 ● JPEG with .jpg extension (quality unconstrained) or PNG with .png extension

 ● Color space: RGB (screen standard)

 ● Minimum size of 1400 x 1400 pixels. 2400 x 2400 pixels recommended for best results.

 ● Images must be square

 ● File formats: JPEG or PNG (100% quality)

 ● 1:1 aspect ratio

Do not increase the size of a smaller image to meet the minimum size standard. Excessively blurry or pixelated
images will be rejected.

Important  CMYK (print standard) images will not be accepted.

Music Digital Booklet Profile
 ● PDF format with .pdf extension

 ● Four-page minimum

 ● No more than 10 MB in size

 ● All fonts embedded

 ● 11 in x 8.264 in (28 cm x 21 cm)

 ● RGB color

 ● Horizontal presentation

 ● All images full-bleed as shown in sample pages

Important  These booklets are expressly designed for the iTunes Store format, and cannot be reproductions
of the liner notes with borders to increase their size.

Music Audio Content Profiles
Music Album Cover Art Profile
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Content Considerations
 ● When saving as PDF, make sure the document opens full screen with no negative space surrounding the

document.

 ● If the digital booklet is many pages, consider using fewer images or optimizing images to achieve lower
overall file size.

 ● Printer’s marks are not allowed.

 ● You cannot sell or advertise other products or services. No other promotional sites are allowed.

 ● No links to anything outside of the booklet, except to the artist and/or label website(s).

 ● No time-sensitive information (for example, a promotion or dates for an upcoming tour or concert).

Music Audio Content Profiles
Music Digital Booklet Profile
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Note  Chaptering is not supported for music videos.

Music Video SD Source Profile

NTSC
 ● MPEG-2 Program Stream Main Profile

 ● 4:2:0 chroma sampling

 ● ITU-R BT.601 color space

 ● 15 Mbps minimum

 ● Long GOP

 ● 640 fixed horizontal dimension

 ● Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ● Square pixel aspect ratio (1:1)

 ● Native frame rate of original source: 

 ● 29.97 interlaced frames per second video source can be delivered either interlaced or de-interlaced
properly tagged as progressive

 ● 24 frames per second must be delivered progressive

 ● 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ● Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ● Telecine materials will not be accepted

 ● For mixed frame rate material please contact your iTunes Technical Representative

 ● Interlaced content must be tagged non-progressive and field ordering must be defined in the stream.

 ● Crop inactive pixels and maintain fields. All edges must have active pixels for greater than 90% of the
duration of the video.
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PAL
 ● MPEG-2 Program Stream Main Profile

 ● 4:2:0 chroma sampling

 ● ITU-R BT.601 color space

 ● 15 Mbps minimum

 ● Long GOP

 ● 640 fixed horizontal dimension

 ● Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ● Square pixel aspect ratio (1:1)

 ● Native frame rate of original source:

 ● 25 interlaced frames per second sourced from video must be delivered de-interlaced and properly
tagged as progressive 

 ● 24 and 25 frames per second sourced from film must be delivered progressive

 ● 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ● Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ● Telecine or interlaced materials will not be accepted

 ● For mixed frame rate material please contact your iTunes Technical Representative

 ● Crop inactive pixels. All edges must have active pixels for greater than 90% of the duration of the video.

Important  All video must begin and end with at least one black frame.

Music Video HD Source Profile
 ● Apple ProRes 422 (HQ)

 ● VBR expected at ~220 Mbps

 ● 1920 x 1080 square pixel aspect ratio material

 ● Native frame rate of original source:

 ● 29.97 interlaced frames per second for video sourced

 ● 24 or 25 progressive frames per second for film sourced

 ● 23.976 progressive frames for inverse telecine sourced from film

Music Video Content Profiles
Music Video HD Source Profile
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 ● Telecine materials will not be accepted

 ● HD source may be delivered matted: letterbox, pillarbox, or windowbox.

 ● The HD source may be delivered in its full-frame state with metadata included to specify the crop
rectangle. See “Music Video Single” in the iTunes Package Music Specification for details.

 ● If the HD source file is not delivered matted or if there are no inactive pixels, we recommend setting
all crop dimension attributes to '0' (zero).

Important  All video must begin and end with at least one black frame.

Music Video Audio Source Profile
If 5.1 Surround is available for a music video audio source, the audio should be delivered in 5.1 Surround in
addition to providing a stereo version; otherwise the audio may be delivered in Stereo only.

Surround

 ● LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ● Expected channels: L, R, C, LFE, Ls, Rs

Stereo

 ● MPEG-1 layer II stereo

 ● 384 kpbs

 ● 48Khz

 ● Included in the same file as the delivered video

Music Video Audio/Video Container
 ● Deliver all content in an MPEG-2 Program Stream file container

 ● The .mpg file extension is expected for all MPEG-2 content

 ● Audio must be delivered muxed with the video stream

Music Video Content Profiles
Music Video Audio Source Profile
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Note  Closed-captioning is currently not supported for music videos.

Music Video Screen Capture Image Profile
 ● Screen capture from delivered video

 ● JPEG with .jpg extension (quality unconstrained) or PNG with .png extension

 ● RGB (screen standard)

 ● Minimum dimensions: Must be 640 x 100 pixels.

 ● Variable size vertical dimension. Must be same aspect ratio as video source, with a maximum size of 480.

 ● Only the active pixel area may be included.

Do not increase the size of a smaller image to meet the minimum size standard. Excessively blurry or pixelated
images will be rejected. Images must be taken directly from the video.

Important  CMYK (print standard) images will not be accepted.

Music Video Content Profiles
Music Video Screen Capture Image Profile
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HD TV Source Profile
 ● Apple ProRes 422 (HQ)

 ● ITU-R BT.709 color space, file tagged correctly as 709

 ● VBR expected at 88-220 Mbps

 ● 1920 x 1080 or 1280 x 720 square pixel aspect ratio material*

 ● 23.976, 24, 25, 29.97 frame rates are supported

 ● Native frame rate of original source: 

 ● 29.97 interlaced frames per second video source can be delivered either interlaced or de-interlaced
properly tagged as progressive

 ● 24 and 25 frames per second must be delivered progressive

 ● 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ● Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ● Fields and frames may not be duplicated or eliminated to create a broadcast frame rate (for example,
telecine, NTSC to PAL conversion)

 ● For mixed frame rate material please contact your iTunes Technical Representative

 ● Interlaced content must be correctly tagged as interlaced and field ordering must be defined in the
QuickTime container.

 ● Crop dimensions should be supplied in the metadata for content with inactive pixels due to letterbox,
pillarbox, or windowbox. Please refer to the iTunes Package TV Specification for further information.

 ● Content upscaled from SD will be rejected.

* If your mezzanine library is not stored in HD D5 or HDCam-SR, contact your iTunes Technical Representative.
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SD TV Source Profile

NTSC
 ● MPEG-2 Program Stream Main Profile

 ● 4:2:0 chroma sampling

 ● ITU-R BT.601 color space

 ● 15 Mbps minimum

 ● Long GOP

 ● 640 fixed horizontal dimension

 ● Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ● Square pixel aspect ratio (1:1)

 ● Native frame rate of original source:

 ● 29.97 interlaced frames per second video source can be delivered either interlaced or de-interlaced
properly tagged as progressive

 ● 24 frames per second must be delivered progressive

 ● 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ● Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ● Fields and frames may not be duplicated or eliminated to create a broadcast frame rate (for example,
telecine, NTSC to PAL conversion)

 ● For mixed frame rate material please contact your iTunes Technical Representative

 ● Interlaced content must be tagged non-progressive and field ordering must be defined in the stream.

 ● Crop inactive pixels and maintain fields. All edges must have active pixels for greater than 90% of the
duration of the video.

 ● Content may NOT be delivered letterbox, pillarbox, or windowbox.

PAL
 ● MPEG-2 Program Stream Main Profile

 ● 4:2:0 chroma sampling

 ● ITU-R BT.601 color space

 ● 15 Mbps minimum

Television Content Profiles
SD TV Source Profile
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 ● Long GOP

 ● 640 fixed horizontal dimension

 ● Variable size vertical dimension depending on aspect ratio of source, maximum size of 480

 ● Square pixel aspect ratio (1:1)

 ● Native frame rate of original source:

 ● 25 interlaced frames per second sourced from video must be delivered de-interlaced and properly
tagged as progressive

 ● 24 and 25 frames per second sourced from film must be delivered progressive

 ● 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ● Field dominance must be properly tagged (top field first, bottom field first, or progressive)

 ● Interlaced materials will not be accepted

 ● Fields and frames may not be duplicated or eliminated to create a broadcast frame rate (for example,
telecine, NTSC to PAL conversion)

 ● For mixed frame rate material please contact your iTunes Technical Representative

 ● Crop inactive pixels. All edges must have active pixels for greater than 90% of the duration of the video.

 ● Content may NOT be delivered letterbox, pillarbox, or windowbox.

Important  All video must begin and end with at least one black frame.

TV Audio Source Profile

MPEG-2 Program Stream Container
Stereo

 ● MPEG-1 layer II

 ● 384 kpbs

 ● 48Khz

 ● Included in the same file as the delivered video

Television Content Profiles
TV Audio Source Profile
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QuickTime Container
Surround

 ● LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ● Expected channels: L, R, C, LFE, Ls, Rs

Stereo

 ● LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ● Expected Dolby Pro Logic channels: Lt, Rt or expected stereo channels: L, R

TV Audio/Video Container

MPEG-2 Program Stream Container
 ● Deliver all content in an MPEG-2 Program Stream file container.

 ● The .mpg file extension is expected for all MPEG-2 content.

 ● Audio must be delivered muxed with the video stream.

QuickTime Container
 ● Deliver all content in a QuickTime .mov file container.

 ● The QuickTime .mov file extension is expected for all audio and video content.

Television Content Profiles
TV Audio/Video Container
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 ● Each audio channel must have an assignment. The channel assignments must match one of the options
below. Note that "Lt" and "Rt" are only used for Dolby matrix audio mixdown. If audio doesn't conform,
contact your iTunes Technical Representative.

Option 1

5.1 Surround Tracks Stereo Tracks
RL C Lfe Ls Rs Lt Rt

Track 1 -- six channels Track 2
RL C Lfe Ls Rs Lt Rt

Track 3

One track containing all Surround channels; Matrix Stereo with Lt in one track and Rt channel in another track

RL C Lfe Ls Rs Lt RtOption 2 Track 1 Track 2 Track 3 Track 4 Track 5 Track 6 Track 7 Track 8

One track for each channel

Option 3 Track 1 -- six channels Track 2 -- two channels
RL C Lfe Ls Rs Lt Rt

One track containing all Surround channels; Matrix Stereo with Lt and Rt channels in one track

RL C Lfe Ls Rs
Option 4 Track 1 Track 2 Track 3 Track 4 Track 5 Track 6

One track for each Surround channel; Matrix Stereo with Lt and Rt channels in one track

Track 7 -- two channels
Lt Rt

Option 5

No Surround. Stereo with L in one track and R in another track

L R
Track 1 Track 2

Option 6

No Surround. Stereo with both L and R channels in one track

Track 1 -- two channels
L R

Important  Refer to “Table 1: Audio Channel Assignment Labels” (page 36) for label descriptions and “How
to Apply Audio Channel Assignments” (page 30) for instructions on applying audio channel assignments.

TV Closed Captioning Profile

Note  Closed captioning can only be sent with ProRes files.

 ● English text in EIA 608 format.

 ● Delivered in the same package with the video it references.

 ● In a Scenarist SCC formatted file, using .scc file extension.

Television Content Profiles
TV Closed Captioning Profile
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 ● SCC files must be 29.97 regardless of frame rate of the movie file. Note: Captioning workflows utilizing
23.976 FPS timecodes can be accepted but the timecodes will be regarded as 29.97 FPS.

 ● SCC files should preserve the timecode mode (drop or non-drop) used in your captioning process, not
necessarily the mode represented in the QuickTime movie source.

 ● SCC files must be validated for proper sync against the associated video file using QuickTime 7 Pro.

 ● Captions should display and synchronize to within one second of the initial, audible dialog to be represented
in text.

The timecodes of the captions are relative to the start of the program, and not the QuickTime movie's timecode
track.

Currently, the iTunes Store does not support EIA 708 (ATSC closed captioning) or Teletext.

MacCaption is a tool you can use to create .scc files: http://www.cpcweb.com/products/. (Note that this
product is not endorsed by Apple. Apple cannot and does not provide support for third-party products.)

Note  If closed caption data is available for any broadcast or web delivery system, it must be suppled
to iTunes.

TV Cover Art Profile
 ● JPEG with .jpg extension (quality unconstrained) or PNG with .png extension

 ● RGB (screen standard)

 ● 1400 x 1400 pixels minimum size (2400 x 2400 recommended for best results)

 ● 1:1 aspect ratio

Do not increase the size of a smaller image to meet the minimum size standard. Excessively blurry or pixelated
images will be rejected.

Important  CMYK (print standard) images will not be accepted.

Television Content Profiles
TV Cover Art Profile
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TV Content Considerations
 ● No bugs or logos should be visible during the body of the video.

 ● No tune-ins should be visible during the body of the video. Tune-ins are only acceptable at the end of the
video.

 ● No ratings or advisories should be displayed at any time during the video.

 ● Network cards at the beginning and end of the video are accepted as long as they are visible less than
five (5) seconds.

 ● Commercials or other promotional material, including URLs, are NOT accepted. For more details, please
contact your iTunes Technical Representative.

 ● Commercial black may be a maximum of 5 seconds.

 ● Previews must contain content suitable for a general audience.

 ● Previews must not have opening or ending credits and should not start on a black frame.

 ● A minimum of 1 black frame at the beginning and end of each video is required.

Television Content Profiles
TV Content Considerations
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Film HD Source Profile
 ● Apple ProRes 422 (HQ)

 ● ITU-R BT.709 color space, file tagged correctly as 709

 ● VBR expected at ~220 Mbps

 ● 1920 x 1080 square pixel aspect ratio material

 ● Native frame rate of original source:

 ● 29.97 interlaced frames per second for video sourced

 ● 24 or 25 progressive frames per second for film sourced

 ● 23.976 progressive frames for inverse telecine sourced from film

 ● Telecine materials will not be accepted

 ● Content may be delivered matted: letterbox, pillarbox, or windowbox.

Important  All videos must begin and end with at least one black frame.

Film SD Source Profile

NTSC
 ● Apple ProRes 422 (HQ)

 ● VBR expected at 40-60 Mbps

 ● 720 x 480 or 720 x 486 encoded pixels; for display at either 853 x 480 for 16:9 content or 640 x 480 for 4:3
content

 ● All encoded content must include pixel aspect ratio (pasp) that defines content as either 4:3 or 16:9.

 ● Native frame rate of original source:

 ● 29.97 frames per second video source can be delivered interlaced

 ● 24 frames per second must be delivered progressive
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 ● 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ● Telecine materials will not be accepted

 ● Content may be delivered matted: letterbox, pillarbox, or windowbox.

PAL
 ● Apple ProRes 422 (HQ)

 ● VBR expected at 40-60 Mbps

 ● 720 x 576 encoded pixels; for display at either 1024 x 576 for 16:9 content or 768 x 576 for 4:3 content

 ● All encoded content must include pixel aspect ratio (pasp) that defines content as either 4:3 or 16:9.

 ● Native frame rate of original source:

 ● 24 and 25 frames per second sourced from film must be delivered progressive

 ● 23.976 frames per second for inverse telecine must be delivered progressive; must not be delivered
interlaced or delivery will fail

 ● Telecine materials will not be accepted

 ● Content may be delivered matted: letterbox, pillarbox, or windowbox.

25 fps interlaced PAL films are NOT supported.

Important  All videos must begin and end with at least one black frame.

Film Audio Source Profile
For every film that 5.1 Surround audio is available in any competing format or market, it must be provided to
iTunes in addition to the stereo tracks.

Surround

 ● LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ● Expected channels: L, R, C, LFE, Ls, Rs

Stereo

 ● LPCM in either Big Endian or Little Endian, 16-bit or 24-bit, at least 48kHz

 ● Expected Dolby Pro Logic channels: Lt, Rt or expected stereo channels: L, R

Film Content Profiles
Film Audio Source Profile
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Film Audio/Video and Alt-Audio Container
 ● Deliver all content in a QuickTime .mov file container.

 ● The QuickTime .mov file extension is expected for all audio and video content.

 ● Each audio channel must have an assignment. The channel assignments must match one of the options
below:

Option 1

5.1 Surround Tracks Stereo Tracks
RL C Lfe Ls Rs Lt Rt

Track 1 -- six channels Track 2
RL C Lfe Ls Rs Lt Rt

Track 3

One track containing all Surround channels; Matrix Stereo with Lt in one track and Rt channel in another track

RL C Lfe Ls Rs Lt RtOption 2 Track 1 Track 2 Track 3 Track 4 Track 5 Track 6 Track 7 Track 8

One track for each channel

Option 3 Track 1 -- six channels Track 2 -- two channels
RL C Lfe Ls Rs Lt Rt

One track containing all Surround channels; Matrix Stereo with Lt and Rt channels in one track

RL C Lfe Ls Rs
Option 4 Track 1 Track 2 Track 3 Track 4 Track 5 Track 6

One track for each Surround channel; Matrix Stereo with Lt and Rt channels in one track

Track 7 -- two channels
Lt Rt

Option 5

No Surround. Stereo with L in one track and R in another track

L R
Track 1 Track 2

Option 6

No Surround. Stereo with both L and R channels in one track

Track 1 -- two channels
L R

Important  Refer to “Table 1: Audio Channel Assignment Labels” (page 36) for label descriptions and
“How to Apply Audio Channel Assignments” (page 30) for instructions on applying audio channel
assignments.

Note  For more information on alternate audio, see the “Assets and Data Files” section in the
iTunes Package Film Specification .

Film Content Profiles
Film Audio/Video and Alt-Audio Container
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Film Closed Captioning Profile
 ● English text in EIA 608 format.

 ● Delivered in the same package with the video it references.

 ● In a Scenarist SCC formatted file, using .scc file extension.

 ● SCC files must be 29.97 regardless of frame rate of the movie file. Note: Captioning workflows utilizing
23.976 FPS timecodes can be accepted but the timecodes will be regarded as 29.97 FPS.

 ● SCC files should preserve the timecode mode (drop or non-drop) used in your captioning process, not
necessarily the mode represented in the QuickTime movie source.

 ● SCC files must be validated for proper sync against the associated video file using QuickTime 7 Pro.

 ● Captions should display and synchronize to within one second of the initial, audible dialog to be represented
in text.

The timecodes of the captions are relative to the start of the program, and not the QuickTime movie's timecode
track.

Currently, the iTunes Store does not support EIA 708 (ATSC closed captioning) or Teletext.

MacCaption is a tool you can use to create .scc files: http://www.cpcweb.com/products/. (Note that this product
is not endorsed by Apple. Apple cannot and does not provide support for third-party products.)

Note  The closed caption file must be provided unless it does not exist.

Film iTunes Timed Text Profile
Below is a summary of delivery requirements for iTunes Timed Text. Refer to Chapter 5 in the iTunes Package
Film Specification for complete details.

 ● Delivered in an iTunes Timed Text (iTT) formatted file, using .itt file extension.

 ● Delivered in the same package with the video it references as an asset in the <assets> block.

 ● Only one div element is allowed in an iTT document.

 ● timeBase must be set to smpte.

 ● dropMode must be set to "dropNTSC" or "nonDrop"; iTunes Timed Text does not support dropPAL.

 ● Only sansSerif may be specified as the typeface in fontFamily.

Film Content Profiles
Film Closed Captioning Profile
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The iTT file format is a subset of the Timed Text Markup Language, Version 1.0 W3C Candidate Recommendation
23 February 2010 (TTML) (http://www.w3.org/TR/2010/CR-ttaf1-dfxp-20100223/) from the World Wide Web
Consortium (W3C) (http://w3.org/). All iTT documents are TTML documents that use the restricted subset of
TTML.

Film Dub Card Video Profile
The full feature-length video asset is comprised of a set of data files, which play specific roles for their asset.
The following table describes the optional data file for dub card video.

DescriptionData FileAsset
Type

A video-only sequence containing one or more still
credits specific to the locale-matched audio. iTunes
products will include dub credit video sequences for
the associated audio dubs following the main
program.

Locale: Required

Role: video.end.dub_credits

An optional data file containing
the credits associated with an
audio track.

Full

Dub Card Video Profile
 ● Apple ProRes 422 (HQ)

 ● Movie correctly tagged with color parameter: ITU BT.709

 ● Video dimensions, pixel aspect ratio, and frame rate must match full program video

 ● Minimum of 4 seconds per dub card

 ● Crop dimensions from full program video will be applied to all dub card video — effective crop must
match full program video

 ● Crop attributes must not be supplied for dub card video

 ● Sound tracks should not be supplied for dub card video — sound tracks will be ignored

 ● Dub card video will be deinterlaced if necessary so the field order does not need to match — progressive
is preferred

 ● Dissolves and scrolling credits are not supported

 ● First and last frames do not need to be black frames

Film Content Profiles
Film Dub Card Video Profile
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Film Chapter Image Profile
 ● JPEG with .jpg extension (quality unconstrained)

 ● RGB (screen standard)

 ● Must be same aspect ratio as video source

 ● 640 minimum horizontal dimension (larger for HD sourced)

 ● Variable size vertical dimension (based on aspect ratio of video source)

 ● Only active pixel area may be included

 ● Chapter images must be cropped (no letterbox, pillarbox, or windowbox)

 ● Chapter images must contain picture content

 ● Chapter image files must be unique with different checksums

Important  CMYK (print standard) images will not be accepted.

Film Poster Art Profile
 ● JPEG with .jpg extension (quality unconstrained) or PNG with .png extension

 ● RGB (screen standard)

 ● 1400 x 2100 pixels minimum size

 ● 2:3 aspect ratio

 ● Poster art (one-sheet) from film. Must contain key art and title. DVD cover, release date, website, or
promotional tagging may not be included.

 ● Poster art must not display film ratings.

Do not increase the size of a smaller image to meet the minimum size standard. Excessively blurry or pixelated
images will be rejected.

Important  CMYK (print standard) images will not be accepted.

Film Content Profiles
Film Chapter Image Profile
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Film Content Considerations
 ● The full movie asset should not contain FBI, MPAA, or release date tagging.

 ● The trailer asset should not contain FBI, MPAA, or release date tagging.

 ● A minimum of 1 black frame at the beginning and end of each video is required.

 ● Trailer should be same aspect ratio as the full asset.

 ● Promotional bumpers, including URLs, are NOT accepted. For more details, please contact your iTunes
Technical Representative.

 ● Trailers must contain content suitable for a general audience.

 ● Poster art should not contain DVD tagging, release date tagging, or website tagging.

Film Content Profiles
Film Content Considerations
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 ● All XML must be encoded in UTF-8.

 ● No byte order markers (BOM) can be used.

 ● There should be no null data or empty tags in the XML. If not used, elements should be removed.

 ● The XML must be formatted to use line breaks and indentations.

For further information, please refer to the appropriate media type metadata specification, or consult with
your iTunes Technical Representative.
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Previous Spec Revisions
The following table lists the previously-released specifications and the revisions:

SummaryDate/Version

Added crop dimensions for TV. Clarified content considerations for
TV. Clarified closed captioning for TV. Added delivery requirements
for iTT files.

September 22, 2011 - Version
4.8

Clarified delivery requirements for 5.1 audio and closed captioning.
Added the profile for closed captioning for TV. Film poster art
requirements have changed.

July 13, 2011 - Version 4.7
Revision 2

Clarified HD cropping for TV. Added color space requirement for HD
film source. Clarified closed captioning text for film.

April 15, 2011 - Version 4.7

Removed asset specifications for books (a new iBookstore asset guide
has been created). Renamed this asset guide to: iTunes Video and
Audio Asset Guide .

February 9, 2011 - Version 4.6

Clarified surround sound for HD music video audio source profile.
Clarified delivery of HD source for music videos. Added a chapter for
book source profiles. Put back 25 fps in the HD TV source profile that
was incorrectly removed. Added two new best practice items to the
TV Content Considerations section.

November 5, 2010 - Version
4.5

Added source profile for HD music video and cropping information.
Clarified album cover art. Added surround sound to HD music video
audio source profile.

August 5, 2010 - Version 4.4

Clarified that ALAC in a CAF container is allowed. Added source profile
for pre-cut ringtones. Clarified that film ratings should not appear on
poster art.

February 3, 2010 - Version 4.3

Clarified quality standards. Clarified closed captioning.December 18, 2009 - Version
4.2

Clarified audio requirements for music and film.November 10, 2009 - Version
4.1
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SummaryDate/Version

Added best practices content for Film. Clarified requirements for SCC
files.

September 11, 2009 - Version
4.0

Clarified image and audio requirements. Clarified frame rate
requirements for TV.

July 1, 2009 - Version 3.3.2

Added support for PNG format images for cover art, poster art, and
video screen captures. PNG images are not currently supported for
chapter thumbnail images.

May 12, 2009 - Version 3.3.1

Added updated PAL support for film. Added closed-captioning to Film
Content Profile. Added 24-bit support for audio. Added best practices
content for TV. Clarified how to send stereo sound for Film and TV.

March 17, 2009 - Version 3.3

Added audio source specification to Music Audio Content Profile,
added HD format to Television Content Profile and Appendix I, which
provides audio channel assignments instructions.

October 1, 2008 - Version 3.2

Complete reformatting of the Guide. Separation of content type
profiles. Addition of Movie HD and SD specification. Addition of image
specifications for TV and Film.

May 8, 2008 - Version 3.1.1

Introduction of Asset Specification Guide.April 2, 2007 - Version 2.3

Revision History
Previous Spec Revisions
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How to Apply Audio Channel Assignments
Step 1: Open the Movie Properties window from the Window > Show Movie Properties menu.

Important  You must use the Pro version of QuickTime.
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Standard Movie Properties window:

Audio Channel Assignments
How to Apply Audio Channel Assignments
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Step 2: Go to the View > Columns menu and choose Channels. You may add additional columns like ID, Data
Rate, and so on.

Audio Channel Assignments
How to Apply Audio Channel Assignments

2012-05-22   |   © 2012 Apple Inc. All Rights Reserved.

32



Notice the Channels column in the following screenshot indicates the audio tracks are Mono.

Step 3: Select the sound track to make the audio channel assignment and click the Audio Settings tab.

Audio Channel Assignments
How to Apply Audio Channel Assignments
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Step 4: To make the Channel Assignment, choose the appropriate setting from the pop-up menu. Repeat this
process for each audio track.

In this example all the tracks have been properly assigned for the channel assignments of Option 2 as indicated
in the Audio/Video Container section for “Television Content Profiles” (page 13) and “Film Content Profiles” (page
20).

Audio Channel Assignments
How to Apply Audio Channel Assignments
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Notice the Channels column in the following screenshot no longer indicates the audio tracks are Mono.

Notice this indicates the assignment.
This should not indicate mono.

Step 5: Save the file.

Step 6: Open the Movie Inspector from the Window > Show Movie Inspector menu to verify assignments
were applied correctly.

Audio Channel Assignments
How to Apply Audio Channel Assignments
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Table 1: Audio Channel Assignment Labels

DescriptionLabel

LeftL

RightR

CenterC

LFE ScreenLFE

Left SurroundLs

Right SurroundRs

Left TotalLt*

Right TotalRt*

* Lt and Rt are supported in the latest version of QuickTime.

Audio Channel Assignments
How to Apply Audio Channel Assignments
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Apple Inc.
© 2012 Apple Inc.
All rights reserved.

No part of this publication may be reproduced,
stored in a retrieval system, or transmitted, in any
form or by any means, mechanical, electronic,
photocopying, recording, or otherwise, without
prior written permission of Apple Inc., with the
following exceptions: Any person is hereby
authorized to store documentation on a single
computer for personal use only and to print
copies of documentation for personal use
provided that the documentation contains
Apple’s copyright notice.

The Apple logo is a trademark of Apple Inc.

No licenses, express or implied, are granted with
respect to any of the technology described in this
document. Apple retains all intellectual property
rights associated with the technology described
in this document. This document is intended to
assist application developers to develop
applications only for Apple-labeled computers.

Apple Inc.
1 Infinite Loop
Cupertino, CA 95014
408-996-1010

.Mac is a registered service mark of Apple Inc.

iBookstore is a service mark of Apple Inc.

iTunes Store is a registered service mark of Apple
Inc.

Apple, the Apple logo, iBook, iBooks, iTunes,
Logic, Mac, and QuickTime are trademarks of
Apple Inc., registered in the United States and
other countries.

DEC is a trademark of Digital Equipment
Corporation.

Dolby and Pro Logic are trademarks of Dolby
Laboratories.

Even though Apple has reviewed this document,
APPLE MAKES NO WARRANTY OR REPRESENTATION,
EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THIS
DOCUMENT, ITS QUALITY, ACCURACY,
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR
PURPOSE. AS A RESULT, THIS DOCUMENT IS PROVIDED
“AS IS,” AND YOU, THE READER, ARE ASSUMING THE
ENTIRE RISK AS TO ITS QUALITY AND ACCURACY.

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT,
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES RESULTING FROM ANY DEFECT OR
INACCURACY IN THIS DOCUMENT, even if advised of
the possibility of such damages.

THE WARRANTY AND REMEDIES SET FORTH ABOVE
ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL
OR WRITTEN, EXPRESS OR IMPLIED. No Apple dealer,
agent, or employee is authorized to make any
modification, extension, or addition to this warranty.

Some states do not allow the exclusion or limitation
of implied warranties or liability for incidental or
consequential damages, so the above limitation or
exclusion may not apply to you. This warranty gives
you specific legal rights, and you may also have other
rights which vary from state to state.
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